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Preface

Oracle Identity Manager Connector Guide for PeopleSoft User Management provides 
information about integrating Oracle Identity Manager with PeopleSoft User 
Management.

Audience
This guide is intended for users who want to deploy the Oracle Identity Manager 
connector for PeopleSoft User Management.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Note: Some parts of the product and documentation still refer to the 
original Thor company name and Xellerate product name and will be 
rebranded in future releases.
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TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398.

Related Documents
For more information, refer to the following documents in the Oracle Identity 
Manager documentation library:

■ Oracle Identity Manager Release Notes

■ Oracle Identity Manager Installation Guide for JBoss

■ Oracle Identity Manager Installation Guide for Oracle Containers for J2EE

■ Oracle Identity Manager Installation Guide for WebLogic

■ Oracle Identity Manager Installation Guide for WebSphere

■ Oracle Identity Manager Administrative and User Console Guide

■ Oracle Identity Manager Administrative and User Console Customization Guide

■ Oracle Identity Manager Design Console Guide

■ Oracle Identity Manager Tools Reference Guide

■ Oracle Identity Manager Audit Report Developer Guide

■ Oracle Identity Manager Best Practices Guide

■ Oracle Identity Manager Globalization Guide

■ Oracle Identity Manager Glossary of Terms

The following document is available in the Oracle Identity Manager Connector Pack 
documentation library:

■ Oracle Identity Manager Connector Framework Guide

Documentation Updates
Oracle is committed to delivering the best and most recent information available. For 
information about updates to the Oracle Identity Manager Connector Pack Release 
9.0.4 documentation library, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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 What's New in the Oracle Identity Manager 
Connector for PeopleSoft User 

Management?

This chapter provides an overview of the updates made to the software and 
documentation for the PeopleSoft User Management connector in releases 9.0.4 of the 
Oracle Identity Manager connector pack.

The updates discussed in this chapter are divided into the following categories:

■ Software Updates

These include updates made to the connector software.

■ Documentation-Specific Updates

These include major changes made to the connector documentation. These 
changes are not related to software updates.

Software Updates
This section discusses updates made to this release of the connector software.

Enabling Logging
By following the instructions in the "Enabling Logging" section on page 2-4, you can 
configure the generation of log information that is specific to the target system.

Partial Reconciliation
You can customize the reconciliation process by specifying the subset of added or 
modified target system records that must be reconciled. This features is discussed in 
the "Partial Reconciliation" section on page 3-1.

Specifying the Number of Records to Be Reconciled
In this release of the connector, you can specify the number of records to be reconciled. 
This feature is discussed in the "Specifying the Number of Records to Be Reconciled" 
section on page 3-2.

See Also: The 9.0.3 release of this guide for information about 
updates that were new for the 9.0.3 release

See Also: Oracle Identity Manager Release Notes
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Separate Scheduled Tasks for Trusted and Nontrusted Source Reconciliation
In this release of the connector, there are separate user reconciliation scheduled tasks 
for trusted and nontrusted source reconciliation. In the "User Reconciliation Scheduled 
Task" section on page 3-18, the attributes of these scheduled tasks are described.

Timeout Feature During Reconciliation and Provisioning
In this release of the connector, you can specify the number of retries and the delay 
between retries for connection attempts from Oracle Identity Manager to the target 
system. The "Defining IT Resources" section on page 2-7, describes the following 
parameters that are used to implement this feature:

■ NumberOfRetries

■ DelayBetweenRetries

Changes to the Testing Utility
The testing utility has been modified. Changes corresponding to the new functionality 
of the testing utility have been made in the following sections:

■ Files and Directories That Comprise the Connector on page 1-6

■ Step 2: Copying the Connector Files and External Code Files on page 2-1

■ Defining IT Resources on page 2-7

The following changes have been made in this section:

– The IsDebug parameter has been removed.

– The IndexOfLastReconciledRecord parameter has been added.

Adding Custom Attributes
This release of the connector supports the adding of custom attributes for 
reconciliation and provisioning. This feature is described in the "Adding Custom 
Attributes for Reconciliation" section on page 3-19 and the "Configuring the Target 
System for Provisioning" section on page 3-27.

Documentation-Specific Updates
The following documentation-specific updates have been made in this release of the 
guide:

■ Instructions in the "Files and Directories That Comprise the Connector" section on 
page 1-6 have been revised.

■ In Step 3 of the procedure described in the ""Configuring PeopleSoft Enterprise 
Portal on PeopleTools 8.45 Through 8.47" section"Configuring PeopleSoft 
Enterprise Portal on PeopleTools 8.45 Through 8.47", the name of the message 
channel has been changed from USR_MGMT_MSG_CH to USR_MGMT_MSGCH.

■ In the "Creating the Application Engine Program" section on page 3-13, the 
addemp step has been added to the list of steps to be created.

■ Information from Appendix B, "Encrypting a New Oracle Identity Manager 
Password" of the earlier release of this guide has been moved to the "Encrypting a 
New Oracle Identity Manager Password" section on page 3-23. The old Appendix 
B has been removed.

■ Information from Appendix C, "Adding Custom Attributes" of the earlier release 
of this guide has been moved to the following sections of Chapter 3:
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■ Adding Custom Attributes for Reconciliation on page 3-19

■ Adding Custom Attributes for Provisioning on page 3-25

The old Appendix C has been removed.

■ Information from Appendix D, "Additional Steps to Be Performed on the Target 
System" of the earlier release of this guide has been moved to the "Configuring the 
Target System for Provisioning" section on page 3-27. The old Appendix D has 
been removed.

■ Some of the content from the Chapter 2 of the earlier release of this guide has been 
moved to Chapter 3.
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1
About the Connector

Oracle Identity Manager automates access rights management, security, and 
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate 
Oracle Identity Manager with third-party applications. The connector for PeopleSoft 
User Management is used to integrate Oracle Identity Manager with PeopleSoft User 
Management.

This chapter contains the following sections:

■ Reconciliation Module

■ Supported Functionality

■ Multilanguage Support

■ Files and Directories That Comprise the Connector

■ Determining the Release Number of the Connector

Reconciliation Module
Reconciliation involves duplicating in Oracle Identity Manager additions of and 
modifications to user accounts on the target system. It is an automated process 
initiated by a scheduled task that you configure.

Based on the type of data reconciled from the target system, reconciliation can be 
divided into the following types:

■ Lookup Fields Reconciliation

■ User Reconciliation

Lookup Fields Reconciliation
The following lookup fields are reconciled:

■ LanguageCode

Note: Oracle Identity Manager connectors were referred to as 
resource adapters prior to the acquisition of Thor Technologies by 
Oracle.

See Also: The "Deployment Configurations of Oracle Identity 
Manager" section in Oracle Identity Manager Connector Framework Guide 
for conceptual information about reconciliation configurations
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■ EmployeeId

■ CurrencyCode

■ PermissionList

■ EmailTypes

The EmailTypes lookup field is reconciled only in PeopleTools 8.45 through 8.47, 
because PeopleTools 8.22 does not support multiple e-mail types.

■ UserRoles

User Reconciliation
User reconciliation involves reconciling the following fields of PeopleSoft User 
Management:

Reconciled Resource Object Fields
The following target system fields are reconciled:

■ UserId

■ UserDescription

■ EmployeeId

■ PrimaryEmailAddress (PeopleTools 8.45 through 8.47 only)

■ PrimaryEmailType (PeopleTools 8.45 through 8.47 only)

■ Email Address (PeopleTools 8.22 only)

■ MultiLanguageCode

■ LanguageCD

■ CurrencyCode

■ Alias (PeopleTools 8.45 through 8.47 only)

■ RowSecurityPermission

■ ProcessProfilePermission

■ NavigatorHomePagePermission

■ PrimaryPermission

■ Secondary EmailAddresses (PeopleTools 8.45 through 8.47 only)

■ Secondary EmailTypes (PeopleTools 8.45 through 8.47 only)

■ Role

Reconciled Xellerate User Fields
The following target system fields are reconciled only if trusted source reconciliation is 
implemented:

■ User ID

■ First Name

■ Last Name

■ Organization

■ User Type
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■ Employee Type

Types of User Data Reconciliation
The connector supports user data reconciliation in two ways:

■ Bulk reconciliation (first-time reconciliation)

Bulk reconciliation involves reconciling records of existing users using a flat file. 
The flat file is generated using an Application Engine program written in 
PeopleCode. This program is run using PeopleSoft Application Designer.

■ Change-based reconciliation

In change-based reconciliation, data for any newly created or updated user is 
reconciled instantaneously. This type of reconciliation is performed using 
PeopleSoft Application Messaging Architecture.

Change-based reconciliation involves the use of:

■ A PeopleCode trigger that generates an XML message containing updated 
information

■ Attribute definitions (usually resource parameters) to be synchronized

■ A Web service that acts as a passive listener for XML messages from 
PeopleSoft

■ An XML file, USR_MGMT_MSG.xml, that defines the schema of the XML 
message received from PeopleSoft

The synchronization process from PeopleSoft User Management to Oracle Identity 
Manager involves the following steps:

1. User information is updated in PeopleSoft User Management. This activates a 
PeopleCode trigger.

2. The PeopleCode trigger generates an XML message containing the updated 
user information and sends it to the listener for the PeopleSoft User 
Management connector.

3. The listener forwards the XML message to the PeopleSoft User Management 
connector using HTTP.

4. The PeopleSoft User Management connector receives the XML message and 
sends a reconciliation event to the Oracle Identity Manager.

Provisioning Module
Provisioning involves creating or modifying a user's account information on the target 
system through Oracle Identity Manager. You use the Administrative and User 
Console to perform provisioning operations.

For this target system, the following fields are provisioned:

■ UserId

■ UserDescription

■ PrimaryPermissionList

See Also: The "Deployment Configurations of Oracle Identity 
Manager" section in Oracle Identity Manager Connector Framework Guide 
for conceptual information about provisioning
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■ RowSecurityPermissionList

■ ProcessProfilePermissionList

■ NavigatorHomePermissionList

■ SymbolicID

■ LanguageCode

■ CurrencyCode

■ PrimaryEmailAddress

■ PrimaryEmailType (for 8.45 and 8.47 only)

■ EmpId

■ RecName

■ Password

■ UserIdAlias (for PeopleTools 8.45 and 8.47 only)

■ MultiLanguageCode

Supported Functionality
The following table lists the functions that are available with this connector.

Note: The "PeopleTools Release" column of this table indicates the 
release of PeopleTools for which the corresponding function is 
available.

Function
PeopleTools 
Release Type Description

Add User 8.22 and 8.45 
through 8.47

Provisioning Creates a user account

Password Updated 8.22 and 8.45 
through 8.47

Provisioning Updates the password of a user

User Description Updated 8.22 and 8.45 
through 8.47

Provisioning Updates the description of a user

Multi Language Code 
Updated

8.22 and 8.45 
through 8.47

Provisioning Updates the multilanguage code of a user

Primary Email Address 
Updated

8.22 only Provisioning Updates the primary e-mail address of a 
user

Email Address Updated 8.22 only Provisioning Updates the e-mail address of a user

Primary Email Type 
Updated

8.45 through 8.47 
only

Provisioning Updates the primary e-mail address type 
of a user

Language Code Updated 8.22 and 8.45 
through 8.47

Provisioning Updates the language code of a user

Currency Code Updated 8.22 and 8.45 
through 8.47

Provisioning Updates the currency code of a user

Employee Id Updated 8.22 and 8.45 
through 8.47

Provisioning Updates the employee ID of a user
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Multilanguage Support
The connector supports the following languages:

■ Chinese Simplified

■ Chinese Traditional

■ English

■ French

■ German

■ Italian

Primary Permission List 
Updated

8.22 and 8.45 
through 8.47

Provisioning Updates the Primary Permission list of a 
user

Process Profile Permission 
List Updated

8.22 and 8.45 
through 8.47

Provisioning Updates the Process Profile Permission 
list of a user

Navigator Home Permission 
List Updated

8.22 and 8.45 
through 8.47

Provisioning Updates the Navigator Home Permission 
list of a user

Row Security Permission 
List Updated

8.22 and 8.45 
through 8.47

Provisioning Updates the Row Security Permission list 
of a user

User Id Alias Updated 8.45 through 8.47 
only

Provisioning Updates the user ID alias of a user

Add RoleName 8.22 and 8.45 
through 8.47

Provisioning Adds a role to a user

Delete RoleName 8.22 and 8.45 
through 8.47

Provisioning Deletes a role from a user

Add EmailAddress 8.45 through 8.47 
only

Provisioning Adds an e-mail address to a user

Delete EmailAddress 8.45 through 8.47 
only

Provisioning Deletes the e-mail address of a user

Enables a User 8.22 and 8.45 
through 8.47

Provisioning Enables a user

Disables a User 8.22 and 8.45 
through 8.47

Provisioning Disables a user

Reconcile Lookup Field 8.22 and 8.45 
through 8.47

Reconciliation Reconciles lookup fields

Reconcile User Data 8.22 and 8.45 
through 8.47

Reconciliation Trusted mode: Reconciles user data from 
PeopleSoft User Management to Oracle 
Identity Manager. A corresponding user 
is created in Oracle Identity Manager. If 
the user already exists in Oracle Identity 
Manager, then this user is updated.

Nontrusted mode: Reconciles user data 
from PeopleSoft User Management to 
Oracle Identity Manager. A user is not 
created in Oracle Identity Manager.

See Also: Appendix A for information about attribute mappings 
between Oracle Identity Manager and PeopleSoft User Management.

Function
PeopleTools 
Release Type Description
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■ Japanese

■ Korean

■ Portuguese (Brazilian)

■ Spanish

Files and Directories That Comprise the Connector
The files and directories that comprise this connector are compressed in the following 
ZIP file on the installation media:

Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft User 
Management

These files and directories are listed in the following table.

See Also: Oracle Identity Manager Globalization Guide for information 
about supported special characters

File in the Installation Media Directory Description

For PeopleTools 8.22:

xml/PT822/PSFTBaseConnector.xml

For PeopleTools 8.45 through 8.47:

xml/PSFTBaseConnector.xml

This XML file contains definitions for the following 
components of the connector:

■ IT resource type

■ IT resource

■ Resource object

■ Process definition

■ Process tasks

■ Adapters

■ Custom Process Form

For PeopleTools 8.22:

xml/PT822/PSFTBaseXellerateUser.xml

For PeopleTools 8.45 through 8.47:

xml/PSFTBaseXellerateUser.xml

This XML file contains the configuration for the Xellerate 
User. You must import this file only if you plan to use the 
connector for trusted source reconciliation.

lib/JavaTasks/PSFTBaseProvisioning.jar This JAR file contains the class files that are required for 
provisioning.

lib/ScheduleTask/PSFTBaseReconciliation.jar This JAR file contains the class files that are required for 
reconciliation.

lib/peopleSoftUserMgmt.war This WAR file contains all the classes and configuration 
files required for the PeopleSoft listener Web application to 
run.
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For PeopleTools 8.22, the following files in the 
test/cbrecon directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

For PeopleTools 8.45 through 8.47, the following 
files in the test/cbrecon directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

These XML files are required by the 
psft-xel-test.vbs file for communicating with the 
PeopleSoft listener Web service using XML over HTTP.

lib/ext/csv.jar The csv.jar file is a third-party library that is used to 
read comma-separated files.

For PeopleTools version 8.22, the following files in 
the PeopleCode/PT822 directory:

AddEmp.txt
CurrencyCode.txt
EmployeeId.txt
LanguageCode.txt
PermissionList.txt
UserRoles.txt

For PeopleTools version 8.45 through 8.47 the 
following files in the PeopleCode directory:

AddEmp.txt
CurrencyCode.txt
EmployeeId.txt
EmailType.txt
LanguageCode.txt
PermissionList.txt
UserRoles.txt

These files contain the PeopleCode for the steps that you 
define for the Application Engine program. Refer to 
"Creating the Application Engine Program" section on 
page 3-13 for details. 

For PeopleTools 8.22:

PeopleCode/PT822/UserMgmtCBRecon.txt

For PeopleTools 8.45 through 8.47:

PeopleCode/UserMgmtCBRecon.txt

This file contains the code that you must add to the 
PeopleCode for the SavePostChange event while 
performing the "Publishing the Message" procedure 
described in the "Creating and Publishing the Message" 
section on page 3-5.

For PeopleTools 8.22, the following files in the 
MsgPublisher directory:

xliMsgPublisher.jar
publish.bat

The JAR file contains the class file that transfers the XML 
messages generated by the PeopleTools 8.22 file handler on 
the PeopleSoft Web server to the PeopleSoft connector 
listener servlet.

The publish.bat file is a Windows batch file that 
triggers the message transfer on a periodic basis. Refer to 
the "Configuring PeopleSoft Enterprise Portal" section on 
page 3-8 for more information.

For PeopleTools 8.22:

test/cbrecon/PT822/psft-xel-test.vbs

For PeopleTools 8.45 through 8.47:

test/cbrecon/psft-xel-test.vbs

This VBScript file is used to test the PeopleSoft listener 
Web service by creating XML messages similar to the ones 
created by PeopleSoft User Management Reconciliation.

File in the Installation Media Directory Description
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The "Step 2: Copying the Connector Files and External Code Files" section on page 2-1 
provides instructions to copy these files into the required directories.

Determining the Release Number of the Connector
You can use any one of the following methods to determine the release number of the 
connector.

For PeopleTools 8.22, the following files in the 
test/cbrecon/PT822 directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

For PeopleTools 8.45 through 8.47, the following 
files in the test/cbrecon directory:

pingRequest.xml
pingResponse.xml
publishRequest.xml
publishResponse.xml

These XML files are required by the 
psft-xel-test.vbs file for communicating with the 
PeopleSoft listener Web service using XML over HTTP.

For PeopleTools 8.22:

test/cbrecon/PT822/USR_MGMT_MSG.xml

For PeopleTools 8.45 through 8.47:

test/cbrecon/USR_MGMT_MSG.xml

This XML file is used by the psft-xel-test.vbs file to 
define the schema of the XML message that is received 
from PeopleSoft.

test/config/config.properties This file is used to specify the parameters and settings 
required to connect to the target system by using the 
testing utility.

test/config/log.properties This file is used to specify the log level and the directory in 
which the log file is to be created when you run the testing 
utility.

test/config/attributemapping_prov.properties This file contains the parameters required for dynamic 
provisioning.

test/config/attributemapping_recon.properties This file contains the parameters required for dynamic 
reconciliation.

test/scripts/psftBase.bat
test/scripts/psftBase.sh

The BAT file or UNIX shell script calls the testing utility 
when the Oracle Identity Manager server is running 
Microsoft Windows or UNIX, respectively. 

For PeopleTools 8.22, the files in the 
resources/PT822 directory

For PeopleTools 8.45 through 8.47, the files in the 
resources directory

Each of these files contains locale-specific information that 
is used by the connector.

Note: The files in the test directory are used only to run tests on 
the connector.

File in the Installation Media Directory Description
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Before Deployment
To determine the release number of a connector:

1. Extract the contents of the PSFTBaseReconciliation.jar file. This file is in 
the following directory on the installation media:

Enterprise Applications/PeopleSoft Enterprise Applications/PeopleSoft User 
Management/lib/ScheduleTask

2. Open the manifest.mf file in a text editor. The manifest.mf file is one of the 
files bundled inside the PSFTBaseReconciliation.jar file.

In the manifest.mf file, the release number of the connector is displayed as the 
value of the Version property.

After Deployment
To determine the release number of a connector that has already been deployed:

1. Open the Oracle Identity Manager Design Console.

2. In the Form Designer, open the process form. The release number of the connector 
is the value of the Version field.

Note: If you maintain a copy of the 
PSFTBaseReconciliation.jar file after deployment, you can use 
this method to determine the release number of the connector at any 
stage. After you deploy the connector, it is recommended that you use 
the "After Deployment" method, which is described in the following 
section.

See Also: Oracle Identity Manager Design Console Guide
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2
Deploying the Connector

Deploying the connector involves the following steps:

■ Step 1: Verifying Deployment Requirements

■ Step 2: Copying the Connector Files and External Code Files

■ Step 3: Configuring the Oracle Identity Manager Server

■ Step 4: Importing the Connector XML Files

Step 1: Verifying Deployment Requirements
The following table lists the deployment requirements for the connector.

Step 2: Copying the Connector Files and External Code Files
The connector files to be copied and the directories to which you must copy them are 
given in the following table.

Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later

Target systems The target system can be any one of the following:

■ PeopleSoft Enterprise Applications 8.3 SP 1

■ PeopleSoft Enterprise Applications 8.9

■ PeopleTools 8.22 and 8.45 through 8.46

You must ensure that the following components are 
installed and configured:

■ Tuxedo and Jolt (the application server)

■ PeopleSoft Internet Architecture

■ PeopleSoft Application Designer (2-tier mode)

Target system host platforms Microsoft Windows

Target system user account PS user

Oracle Identity Manager uses this user account to 
connect to and exchange data with PeopleSoft User 
Management. You provide the credentials of this 
user account while performing the procedure in the 
"Defining IT Resources" section on page 2-7.
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After you copy the connector files, copy the following files from the 
PeopleSoft_home/PT8xx/web/PSJOA directory into the 
OIM_home/xellerate/ThirdParty directory.

■ psjoa.jar

This is the PeopleSoft Java object adapter file.

■ peoplesoft.jar

This JAR file contains APIs for the USER_PROFILE component interface.

The "Creating the APIs for the Component Interface" section on page 3-27 for 
information about the procedure to generate this file for the specific release of 
PeopleTools, 8.22 or 8.45 through 8.47, that you are using.

Note: The directory paths given in the first column of this table 
correspond to the location of the connector files in the following 
directory on the installation media:

Enterprise Applications/PeopleSoft Enterprise 
Applications/PeopleSoft User Management

Refer to the "Files and Directories That Comprise the Connector" 
section on page 1-6 for more information about these files.

File in the Installation Media Directory Destination Directory

lib/JavaTasks/PSFTBaseProvisioning.jar OIM_home/xellerate/JavaTasks

lib/ScheduleTask/PSFTBaseReconciliation.jar OIM_home/xellerate/ScheduleTask

lib/ext/csv.jar OIM_home/xellerate/ThirdParty

For PeopleTools 8.22, copy the files from the 
MsgPublisher directory

OIM_home/xellerate/MsgPublisher

For PeopleTools 8.22, copy the files from the 
PeopleCode/PT822 directory

For PeopleTools 8.45 through 8.47, copy the files 
from the PeopleCode directory

OIM_home/xellerate/Scripts

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.47, not both. 

For PeopleTools 8.22, copy the files from the 
resources/PT822 directory

For PeopleTools 8.45 through 8.47, copy the files 
from the resources directory

OIM_home/xellerate/connectorResources

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.47, not both.

For PeopleTools 8.22, copy the files from the 
test/cbrecon/PT822 directory

For PeopleTools 8.45 through 8.47, copy the files 
from the test/cbrecon directory

OIM_home/xellerate/XLIntegrations/PSFTBASE/cbrecon 

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.47, not both. 

Files in the test/config directory OIM_home/xellerate/XLIntegrations/PSFTBASE/config

For PeopleTools 8.22:

xml/PT822/PSFTBaseConnector.xml
xml/PT822/PSFTBaseXellerateUser.xml

For PeopleTools 8.45 through 8.47:

xml/PSFTBaseConnector.xml
xml/PSFTBaseXellerateUser.xml

OIM_home/xlclient

Note: You must copy the files for either PeopleTools 8.22 or 
PeopleTools 8.45 through 8.47, not both. 
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■ pshttp.jar (PeopleTools 8.45 through 8.47 only)

Create this JAR file using the PeopleSoft class files that are in the pshttp and 
cache directories on the PeopleSoft server. The location of these directories 
depends on the PeopleTools release that you are using. For PeopleTools 4.5, the 
directories are located at the following paths:

pt8.45/class/psft/pt8/pshttp
pt8.45/class/psft/pt8/cache

The pstools.properties file contains the Tuxedo parameter settings used by the 
PeopleSoft Integration Gateway. You must copy it into the 
OIM_home/xellerate/bin directory.

Step 3: Configuring the Oracle Identity Manager Server
Configuring the Oracle Identity Manager server involves the following procedures:

■ Changing to the Required Input Locale

■ Clearing Content Related to Connector Resource Bundles from the Server Cache

■ Enabling Logging

Changing to the Required Input Locale
Changing to the required input locale (language and country setting) involves 
installing the required fonts and setting the required input locale.

You may require the assistance of the system administrator to change to the required 
input locale.

Clearing Content Related to Connector Resource Bundles from the Server Cache
While performing the instructions described in the "Step 2: Copying the Connector 
Files and External Code Files" section on page 2-1, you copy files from the resources 
directory on the installation media into the 
OIM_home/xellerate/connectorResources directory.  Whenever you add a 
new resource bundle in the connectorResources directory or make a change in an 
existing resource bundle, you must clear content related to connector resource bundles 
from the server cache.

To clear content related to connector resource bundles from the server cache:

1. In a command window, change to the OIM_home/xellerate/bin directory.

Note: While installing Oracle Identity Manager in a clustered 
environment, you copy the contents of the installation directory to 
each node of the cluster. Similarly, you must copy the 
connectorResources directory and the JAR files to the 
corresponding directories on each node of the cluster.

Note: In a clustered environment, you must perform this step on 
each node of the cluster.
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2. Enter one of the following commands:

■ On Microsoft Windows:

PurgeCache.bat ConnectorResourceBundle

■ On UNIX:

PurgeCache.sh ConnectorResourceBundle

In this command, ConnectorResourceBundle is one of the content categories 
that you can remove from the server cache. Refer to the following file for 
information about the other content categories:

OIM_home/xellerate/config/xlConfig.xml

Enabling Logging
When you enable logging, Oracle Identity Manager automatically stores in a log file 
information about events that occur during the course of provisioning and 
reconciliation operations. To specify the type of event for which you want logging to 
take place, you can set the log level to one of the following:

■ ALL

This level enables logging for all events.

■ DEBUG 

This level enables logging of information about fine-grained events that are useful 
for debugging.

■ INFO  

This level enables logging of informational messages that highlight the progress of 
the application at coarse-grained level.

■ WARN  

This level enables logging of information about potentially harmful situations.

■ ERROR 

This level enables logging of information about error events that may still allow 
the application to continue running.

■ FATAL

This level enables logging of information about very severe error events that could 
cause the application to stop functioning.

■ OFF   

Note: You must perform Step 1 before you perform Step 2. If you 
run the command described in Step 2 as follows, then an exception is 
thrown:

OIM_home/xellerate/bin/script_file_name

Note: You can ignore the exception that is thrown when you 
perform Step 2.
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This level disables logging for all events.

The file in which you set the log level depends on the application server that you use:

■ BEA WebLogic

To enable logging:

1. Add the following line in the 
OIM_home/xellerate/config/log.properties file:

log4j.logger.Adapter.PSFTBase=log_level

2. In this line, replace log_level with the log level that you want to set.

For example:

log4j.logger.Adapter.PSFTBase=INFO

After you enable logging, log information is written to the following file:

WebLogic_home/user_projects/domains/domain_name/server_name/server_name.log

■ IBM WebSphere

To enable logging:

1. Add the following line in the 
OIM_home/xellerate/config/log.properties file:

log4j.logger.Adapter.PSFTBase=log_level

2. In this line, replace log_level with the log level that you want to set.

For example:

log4j.logger.Adapter.PSFTBase=INFO

After you enable logging, log information is written to the following file:

WebSphere_home/AppServer/logs/server_name/startServer.log

■ JBoss Application Server

To enable logging:

1. In the JBoss_home/server/default/conf/log4j.xml file, locate the 
following lines:

<category name="Adapter.PSFTBase">
   <priority value="log_level"/>
</category>

2. In the second XML code line, replace log_level with the log level that you 
want to set. For example:

<category name="Adapter.PSFTBase">
   <priority value="INFO"/>
</category>

After you enable logging, log information is written to the following file:

JBoss_home/server/default/log/server.log

■ OC4J

To enable logging:
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1. Add the following line in the 
OIM_home/xellerate/config/log.properties file:

log4j.logger.Adapter.PSFTBase=log_level

2. In this line, replace log_level with the log level that you want to set.

For example:

log4j.logger.Adapter.PSFTBase=INFO

After you enable logging, log information is written to the following file:

OC4J_home/opmn/logs/default_group~home~default_group~1.log

Step 4: Importing the Connector XML Files
To import the connector files into Oracle Identity Manager:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management.  A dialog box for locating 
files is displayed.

4. Locate and open the PSFTBaseConnector.xml file, which is in the 
OIM_home/xlclient directory. Details of the XML file are shown on the File 
Review page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Next. The Provide IT Resource Instance Data page for the PSFT Base 
Server IT resource is displayed.

8. Specify values for the parameters of the PSFT Base Server IT resource. Refer to 
the "Defining IT Resources" section on page 2-7 for information about the values to 
be specified.

9. Click Next. The Provide IT Resource Instance Data page for a new instance of the 
PSFTBase IT resource type is displayed.

10. Click Skip to specify that you do not want to define another IT resource. The 
Confirmation page is displayed.

11. Click View Selections.

The contents of the XML file are displayed on the Import page. You may see a 
cross-shaped icon along with some nodes. These nodes represent Oracle Identity 
Manager entities that are redundant. Before you import the connector XML file, 
you must remove these entities by right-clicking each node and then selecting 
Remove.

12. Click Import. The connector file is imported into Oracle Identity Manager.

After you import the connector XML file, proceed to the next chapter.

See Also: If you want to define another IT resource, then refer to 
Oracle Identity Manager Tools Reference Guide for instructions.
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Defining IT Resources
You must specify values for the PSFT Base Server IT resource parameters listed in 
the following table.

After you specify values for these IT resource parameters, go to Step 9 of the procedure 
to import connector XML files.

Parameter Description

Admin User ID of the PeopleSoft User Management administrator

Default value: PS

AdminCredentials Password of the PeopleSoft User Management administrator

ComponentInterfaceName Component interface used to load user data in PeopleSoft User Management

Default value: USER_PROFILE

ServerName IP address or computer name of the PeopleSoft User Management server

ServerPort Port at which the PeopleSoft User Management server is listening

Default value: 9000

IsSecure Specify whether or not the SSL feature is enabled

The value can be YES or NO. The default value is NO.

Note: It is recommended that you enable SSL to secure communication with 
the target system.

SymbolicId Specifies the AccessId associated with the user profile

The AccessId specifies whether or not the user has sufficient privileges on the 
PeopleSoft User Management database. 

Sample value: PS89

RecordName Used to validate the employee ID during user provisioning in PeopleSoft 
User Management

Default value: PERSONAL_DATA

NumberOfRetries Number of times the connection to the target system must be retried before 
the InvocationTargetException is thrown

Default value: 2

Note: The timeout feature is enabled only for bulk reconciliation and 
provisioning. It is not applied during change-based reconciliation. 

DelayBetweenRetries Time difference between subsequent retries (in milliseconds)

Default value: 20000

IndexOfLastReconciledReco
rds

Stores the index of last successful reconciled record

Default value: -1



Step 4: Importing the Connector XML Files

2-8 Oracle Identity Manager Connector Guide for PeopleSoft User Management



Configuring the Connector 3-1

3
Configuring the Connector

After you deploy the connector, you must configure it to meet your requirements. This 
chapter discusses the following connector configuration procedures:

■ Configuring Reconciliation

■ Configuring Provisioning

■ Configuring the Connector for Multiple Installations of the Target System

Configuring Reconciliation
As mentioned earlier in this guide, reconciliation involves duplicating in Oracle 
Identity Manager additions of and modifications to user accounts on the target system. 
This section discusses the following topics related to configuring reconciliation:

■ Partial Reconciliation

■ Configuring the PeopleSoft Listener Web Service for Change-Based Reconciliation

■ Configuring the Target System for Reconciliation

■ Configuring Trusted Source Reconciliation

■ Configuring the Reconciliation Scheduled Tasks

■ Adding Custom Attributes for Reconciliation

■ Encrypting a New Oracle Identity Manager Password

Partial Reconciliation
By default, all target system records that are added or modified after the last 
reconciliation run are reconciled during the current reconciliation run. You can 
customize this process by specifying the subset of added or modified target system 
records that must be reconciled. You do this by creating filters for the reconciliation 
module.

Creating a filter involves specifying values for the following scheduled task attributes, 
which will be used in the query SELECT criteria to retrieve the records to be 
reconciled:

Note: These sections provide both conceptual and procedural 
information about configuring the connector. It is recommended that 
you read the conceptual information before you perform the 
procedures.
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■ UserId

■ UserType (This attribute is used only in trusted source reconciliation)

If you want to use multiple target system attributes to filter records, then you must 
also specify the logical operator (AND or OR) that you want to apply to the 
combination of target system attributes that you select.

For example, suppose you specify the following values for these attributes:

■ UserId=jdoe

This will return results of all users who have the string jdoe in their user IDs. For 
example, records of users with user ID njdoehn, cajdoe, jdoettir, and so on 
are fetched.

■ UserType=Employee

Because you are using the OR operator, during reconciliation, only user records for 
which any one of these criteria is met are reconciled. If you were to use the AND 
operator, then only user records for which all of these criteria are met are reconciled.

While deploying the connector, follow the instructions in the "Specifying Values for the 
Scheduled Task Attributes" section on page 3-17 to specify values for these attributes 
and the logical operator that you want to apply.

Specifying the Number of Records to Be Reconciled
During a reconciliation run, all changes in the target system records are reconciled into 
Oracle Identity Manager. Depending on the number of records to be reconciled, this 
process may require a large amount of time. In addition, if the connection breaks 
during reconciliation, then the process would take longer to complete.

You can specify the number of records to be reconciled. To do this, you use the 
NoOfRecordsToBeReconciled scheduled task attribute.

You specify a value for the NoOfRecordsToBeReconciled attribute by following 
the instructions described in the  "Specifying Values for the Scheduled Task Attributes" 
section on page 3-17.

Configuring the PeopleSoft Listener Web Service for Change-Based Reconciliation
This section describes how to configure the listener for the connector. In the following 
procedure, OIM_home refers to the local Oracle Identity Manager installation 
directory.

To configure the PeopleSoft Listener Web service:

1. Enter the following command to extract the contents of the 
peopleSoftUserMgmt.war file. This file is in the OIM_home/xlclient/lib 
directory.

jar –xvf  peopleSoftUserMgmt.war

2. Edit the deployment.properties file. This file contains the message property 
that corresponds to the name of the XML message from the PeopleSoft feed. The 
default value of this attribute is USR_MGMT_MSG. Obtain the correct value for this 
attribute from the PeopleSoft administrator.

Note: All the files mentioned in the remaining steps of this 
procedure are extracted from the peopleSoftUserMgmt.war file.
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3. If you are using PeopleTools 8.22, then you must modify the PSFTBase.Roles 
property in the attributemap.properties file as follows:

a. Search for the following line:

PSFTBase.Roles=//Transaction/PSROLEUSER_VW/ROLES

b. Replace it with the following line:

PSFTBase.Roles=//Transaction/PSROLEUSER_VW/ROLENAME

4. Edit the xlsession.properties file. This file contains the following Oracle 
Identity Manager connection parameters:

■ ObjectName: This is the name of the resource object in Oracle Identity 
Manager against which the reconciliation event is created. The default value is 
PSFTBase. For nontrusted source reconciliation, you can change it to any 
other resource object.

■ Username: This is the user name for logging in to Oracle Identity Manager. 
The default value is xelsysadm.

■ Password: This is the password for logging in to Oracle Identity Manager. You 
must enter the encrypted value for the default password:

Kk3821YZhIoG36lvDH2YTw==

5. Edit the xlclient.properties file. This file contains the following system 
properties that enable an API client to communicate with Oracle Identity Manager:

■ xl.homedir: This property specifies the Oracle Identity Manager client 
directory. Typically, the Oracle Identity Manager client directory is 
OIM_home/xlclient.

■ java.security.policy: This property specifies the path of the security policy file. 
Typically, this file is located in the OIM_home/xlclient/config directory.

■ java.security.auth.login.config: This property specifies the path of the 
authentication configuration file. Typically, this file is located in the 
OIM_home/xlclient/config directory.

Each application server uses a different authentication configuration file: 

IBM WebSphere: authws.conf

BEA WebLogic: authwl.conf

JBoss Application Server: auth.conf

■ java.naming.provider.url: This property specifies the JNP URL of the 
application server. This URL is given in the 
<Discovery><CoreServer><java.naming.provider.url> tag of the 
OIM_home/xlclient/config/xlconfig.xml file.

6. Edit the following properties in the configureReconciliation.properties 
file:

Note: If the password for Oracle Identity Manager is different from 
the default password, then refer to the "Encrypting a New Oracle 
Identity Manager Password" section on page 3-23 for information 
about encrypting a plaintext password.
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■ reconciliationMode: This property can accept one of two possible values:

– If you want to perform reconciliation in trusted mode, then set this 
property to trusted.

– If you want to perform reconciliation in nontrusted mode, then set this 
property to nontrusted.

■ Serverdateformat: This property specifies the date format that is used by the 
PeopleSoft User Management server. You can select one of the following date 
formats:

– dd-mmm-yy

– ddmmyy

– yyddmm

– yymmdd

■ xellerateOrganization: This property specifies the name of the Oracle Identity 
Manager organization. The default value of this parameter is Xellerate 
Users. The value that you assign to this property must exist in Oracle 
Identity Manager.

■ nullDate: This property specifies the default value for a date field. The value 
is 2200/01/01 00:00:00 PST. This value is used if the date field is left 
empty.

■ PeoplesoftstartingYEAR:  This property specifies the year in two digits. If the 
number represented by these two digits (xx):

– Is greater than or equal to 50, then it is assumed that the year is 19xx.

– Is less than 50, then it is assumed that the year is 20xx.

 This specifies a range of 1950 to 2049 for the property.

■ XelServerDate: This property contains the date format that is used for the 
Oracle Identity Manager server.

Sample value: yyyy/MM/dd hh:mm:ss z 

7. Copy the following files from the OIM_home/xellerate/lib directory to the 
WEB-INF/lib directory:

■ wlXLSecurityProviders.jar

■ xlAPI.jar

■ xlAuthentication.jar

■ xlBackOfficeBeans.jar

■ xlBackofficeClient.jar

■ xlCache.jar

■ xlCrypto.jar

■ xlDataObjectBeans.jar

■ xlDataObjects.jar

■ xlLogger.jar

■ xlUtils.jar

■ xlVO.jar
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Copy the following files from the OIM_home/xellerate/ext directory to the 
WEB-INF/lib directory:

■ oscache.jar

■ javagroups-all.jar

8. Delete the peopleSoftUserMgmt.war file from the temporary directory into 
which you extract it, and then use the following command to re-create the file:

jar –cvf  peopleSoftUserMgmt.war

9. Ensure that the old version of the peopleSoftUserMgmt.war file is removed 
from the application server (JBoss Application Server, IBM WebSphere, BEA 
WebLogic, or OC4J) deployment directory and the 
OIM_home/xellerate/webapp directory.

10. Copy the newly created peopleSoftUserMgmt.war file into the application 
server deployment directory and the OIM_home/xellerate/webapp directory.

11. Restart the Oracle Identity Manager server and client.

Configuring the Target System for Reconciliation
Configuring the target system involves performing the following procedures:

■ Creating and Publishing the Message

■ Configuring PeopleSoft Enterprise Portal

■ Creating the Application Engine Program

Creating and Publishing the Message
The procedure to create and publish the message depends on the release of 
PeopleTools that you are using:

■ Creating and Publishing the Message on PeopleTools 8.22

■ Creating and Publishing the Message on PeopleTools 8.45 Through 8.47

Creating and Publishing the Message on PeopleTools 8.22  Creating and publishing the 
message on PeopleTools 8.22 involves the following steps:

1. To create the message channel:

a. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed.

b. Select New from the File menu. The New Definition dialog box is displayed.

c. Select Message Channel, and then click OK.

d. Save the new message channel as USR_MGMT_MSGCH.

Note: You can add custom attributes to be reconciled during 
change-based reconciliation. However, you must complete the 
deployment procedure before you can add custom attributes.

Refer to the "Adding Custom Attributes for Reconciliation" section on 
page 3-19 for information about the procedure to add custom 
attributes for reconciliation.
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e. Select Object Properties from the File menu. The Message Channel Properties 
dialog box is displayed.

f. Select the Run option, and then select Archive Messages.

g. Click OK, and then save the message.

2. To create the message:

a. In the Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

b. Select Message from the list, and then click OK.

c. Select Object Properties from the File menu. The Message Properties dialog 
box is displayed.

d. Click the Use tab.

e. On the Use tab, select the USR_MGMT_MSGCH message channel and the 
version of the message that you create.

f. Select Active to make the message an active message, and then click OK.

g. Right-click VERSION_1, and select the Insert Child Record option. The Insert 
Record window is displayed.

h. Enter PSOPRDEFN in the Name field, click Insert, and then click Close.

i. Click PSOPRDEFN under VERSION_1. All the fields comprising the 
PSOPRDEFN record are displayed.

By default, all the fields appear as selected. Deselect the fields that are not 
required for the message XML file to be generated.

j. Repeat Steps g through i for the PSROLEUSER_VW record.

k. Save the message as USR_MGMT_MSG.

3. To publish the message:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Component from the Definition list, enter USERMAINT in the Name 
Selection Criteria field, and then click Enter. All component names starting 
with the text USERMAINT are displayed.

c. Select USERMAINT from the list, and then click Open. The details of the 
USERMAINT component are displayed.

d. Click the Structure tab, right-click USERMAINT, and then select View 
PeopleCode. The PeopleCode for the USERMAINT component is displayed.

Note: PSOPRDEFN is a record defined in the 
OIM_home/xellerate/test/cbrecon/USR_MGMT_MSG.xml file. 
Refer to this file for information about the fields that comprise the 
PSOPRDEFN record.

Note: PSROLEUSER_VW is the second record defined in the 
OIM_home/xellerate/test/cbrecon/USR_MGMT_MSG.xml file.
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e. Select the SavePostChange event from the list in the upper-left corner of the 
window. The PeopleCode for this event is displayed.

f. Copy the code given in the following file immediately after the import 
definitions in the PeopleCode for the SavePostChange event:

OIM_home/xellerate/Scripts/UserMgmtCBRecon.txt

g. Select Save from the File menu to save the changes to the USERMAINT 
component.

After you complete this procedure, proceed to the "Configuring PeopleSoft Enterprise 
Portal" section on page 3-8.

Creating and Publishing the Message on PeopleTools 8.45 Through 8.47  Creating and 
publishing the message on PeopleTools 8.45 through 8.47 involves the following steps:

1. To create the message channel:

a. Click Start, Programs, and Application Designer. The Application Designer 
window is displayed in the 2-tier mode.

b. Select New from the File menu. The New Definition dialog box is displayed.

c. Select Message Channel, and then click OK.

d. Save the new message channel as USR_MGMT_MSGCH.

e. Select Definition Properties from the File menu. The Message Channel 
Properties dialog box is displayed.

f. Select the Run option, and then select Archive Messages.

g. Click OK and save the message channel.

2. To create the message:

a. In PeopleSoft Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

b. Select Message from the list, and then click OK.

c. Select Definition Properties from the File menu. The Message Properties 
dialog box is displayed.

d. Click the Use tab.

e. On the Use tab, select the USR_MGMT_MSGCH message channel and the version 
of the message that you create. 

f. Select Active to make the message an active message.

g. Save the message as USR_MGMT_MSG.

3. To publish the message:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Component from the Definition list, enter USERMAINT in the Name 
Selection Criteria field, and then press Enter. All component names starting 
with the text USERMAINT are displayed.

c. Select USERMAINT from the list, and then click Open. The details of the 
USERMAINT component are displayed.

d. Click the Structure tab, right-click USERMAINT, and then select View 
PeopleCode. The PeopleCode for the USERMAINT component is displayed.
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e. Select the SavePostChange event from the list in the upper-left corner of the 
window. The PeopleCode for this event is displayed.

f. Copy the code given in the following file immediately after the import 
definitions in the PeopleCode for the SavePostChange event:

OIM_home/xellerate/Scripts/UserMgmtCBRecon.txt

g. Add the following function call at the end of the PeopleCode for the 
SavePostChange event:

/**********************************************************************/
/*  Calling the GENERATEUSER function to generate the 
USR_MGMT_MSG message*/
/**********************************************************************/
If Len(%CompIntfcName) = 0 Then
  Local string &OPID;
     &OPID = PSOPRDEFN.OPRID;
     GENERATEUSR(&OPID);
End-If;

h. Select Save from the File menu to save the changes to the USERMAINT 
component.

Configuring PeopleSoft Enterprise Portal

PeopleSoft Enterprise Portal provides a single gateway to critical information in 
PeopleSoft User Management Reconciliation and other PeopleSoft applications.

The procedure to configure PeopleSoft Enterprise Portal depends on the release of 
PeopleTools that you are using:

■ Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22

■ Configuring PeopleSoft Enterprise Portal on PeopleTools 8.45 Through 8.47

Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22  Configuring PeopleSoft 
Enterprise Portal on PeopleTools 8.22 involves the following steps:

1. To create the USR_MGMT_NODE remote node:

a. In the Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

b. Select Message Node from the list, and then click OK.

Note: Perform this step only after you copy the code from the 
UserMgmtCBRecon.txt file. 

Note: If your PeopleSoft installation does not include PeopleSoft 
Enterprise Portal, then you cannot perform this procedure. 
Change-based reconciliation cannot be enabled if you do not use 
PeopleSoft Enterprise Portal. However, you can perform provisioning 
and bulk reconciliation.

Refer to the "User Reconciliation" section on page 1-2 for information 
about change-based and bulk reconciliation.
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c. Right-click anywhere in the white space, and then select Insert Location. The 
Location dialog box is displayed.

d. Enter the URL for the PeopleSoft Application Gateway in the following 
format:

http://hostname:port/servlets/gateway

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

e. Select Object Properties from the File menu. The Message Node Properties 
dialog box is displayed.

f. Select the Use tab. Ensure that Local Node is not selected.

g. Save the remote node as USR_MGMT_NODE.

2. To configure the USR_MGMT_MSGCH message channel:

a. From the File menu, select Open and then click Message Channel.

b. To open the USR_MGMT_MSGCH message channel, select 
USR_MGMT_MSGCH.

c. Click the Routing Rules tab.

d. Right-click anywhere in the empty area of the right pane, and then select 
Insert Message Node. The Insert Message Node dialog box is displayed.

e. Select the USR_MGMT_NODE message node, and then click Insert.

f. Click Cancel to close the dialog box.

g. Right-click the message node displayed on the Routing Rules tab. 

h. Point to Routing Direction, and then select Publish To.

i. Save the message channel.

3. To configure the PeopleSoft Enterprise Portal gateway so that messages can be 
sent through the gateway to third-party systems:

a. In a Web browser, use a URL with the following format to launch the 
PeopleSoft configuration servlet interface (handler directory):

http://hostname:port/servlets/gateway.administration

In this URL, hostname is the application server that hosts PeopleSoft and 
port is the port number at which the application server is listening.

b. Click Add Handler. The Add Handler window is displayed.

c. Enter the full name of the Simple File Handler class, 
psft.pt8.filehandler.SimpleFileHandler.

d. Click Save. The Handler Directory window is displayed.

e. To load the handler, click Load. After the handler loads, the "Loaded 
successfully" message is displayed in the Status column.

Note: The Simple File Handler mentioned in the following 
procedure is a utility in PeopleTools 8.22 that can receive messages 
published by a PeopleSoft node and write these messages to a file that 
can be used by third-party systems.
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f. Click Configure.

g. Click Add a file handler node. The Add File Handler Node window is 
displayed.

h. In the Node Name field, enter the name of the message node that you create, 
USR_MGMT_NODE.

i. Specify the output directory in which the published messages are to be stored.

j. Select Include Header.

k. Click Save.

l. Restart the Web server.

4. XML messages are generated by the Simple File Handler. To publish these 
messages to the PeopleSoft Connector Listener servlet, you must create a 
scheduled task as follows:

a. Copy the publish.bat and xliMsgPublisher.jar files from the 
OIM_home/xellerate/MsgPublisher directory to any directory on the  
PeopleSoft User Management server.

b. Use a text editor to open the publish.bat file, and then make the following 
changes in the file:

i. Change the value of the JAVA_HOME variable so that it points to the JDK 
installation directory on the PeopleSoft Web server.

ii.  Specify the following values in the Java command given at the end of the 
file:

* PeopleSoft_listener_servlet_URL: This is the URL of the servlet 
that listens for reconciliation events generated using PeopleSoft 
Application Messaging.

* Output_directory_for_XML_messages: This is the PeopleSoft Web 
server directory in which you want published messages to be stored. You 
have already specified the output directory while performing Step 3.i of 
this procedure.

* XML_message_name

* console_log_file_path

The command is in the following format:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"PeopleSoft_listener_servlet_URL" "Output_directory_for_XML_messages" 
XML_message_name >> console_log_file_path

Note: The scheduled task calls a Java program that communicates 
with the servlet deployed on the Oracle Identity Manager server. The 
servlet parses the message and sends reconciliation events to Oracle 
Identity Manager.

The servlet sends a return code based on the status of the 
reconciliation event. If the reconciliation event is successfully sent, 
then the message is deleted or archived. Otherwise, the message file is 
left unchanged. The next time the scheduled task is run, another 
attempt is made to send the message.
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For example:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://host:port/peopleSoftUserMgmt/do/peopleSoftAction" "C:/test/file" 
USR_MGMT_MSG >> c:/test/consolelog.log

In the PeopleSoft listener servlet URL specified in this example, host is the IP 
address or host name of the application server on which Oracle Identity 
Manager is running and port is the HTTP port at which the application 
server listens for incoming messages.

c. Save and close the batch file.

d. On the PeopleSoft Web server, click Start, Settings, and Control Open.

e. Double-click Scheduled Tasks.

f. Click Add Schedule Task, and then click Next.

g. Click Browse, and then select the publish.bat file from the directory in 
which you save it.

h. Select Daily, click Next, and then click Next again.

i. Enter the user ID and password for the scheduled task to run.

j. Select Open Advance properties.

k. Click Finish.

l. On the Schedule tab, click Advanced.

m. Select Repeat Task.

n. Select the frequency at which you want the task to run.

o. Click OK, and then click OK again to close the window.

Configuring PeopleSoft Enterprise Portal on PeopleTools 8.45 Through 8.47  Configuring 
PeopleSoft Enterprise Portal on PeopleTools 8.45 through 8.47  involves the following 
steps:

1. To configure the PeopleSoft Enterprise Portal gateway so that messages can be 
sent through the gateway to the connector:

a. Open a Web browser and enter the URL for PeopleSoft Enterprise Portal.

This URL is in the following format:

http://servername/psp/Databasename/?cmd=login

Here, psp is the name of the Web application. For example:

http://psftserver.acme.com/psp/TestDB/?cmd=login

b. Expand PeopleTools, Integration Broker, and then Gateways in the list on 
the portal page. The Gateway component details are displayed. 

c. Enter LOCAL in the Integration Gateway ID field, and then click Search. The 
LOCAL gateway is a default gateway that is created when you install 
PeopleSoft Enterprise Portal.

d. Ensure that the IP address specified in the URL of the PeopleSoft listening 
connector is the IP address of the Web server on which PeopleSoft User 
Management is installed. The PeopleSoft listening connector is a  module 
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provided by PeopleSoft. The URL of the PeopleSoft listening connector is in 
the following format:

http://computer_name/PSIGW/PeopleSoftListeningConnector

For example:

http://172.19.151.53/PSIGW/PeopleSoftListeningConnector

e. Click Load Gateway Connectors to load all target connectors that are 
registered with the LOCAL gateway.

f. Click Save.

2. To create the USR_MGMT_NODE remote node:

a. In the PeopleSoft Enterprise Portal window, expand PeopleTools, Integration 
Broker, and Node Definitions.

b. Click the Add a New Value tab.

c. On the Add a New Value tab, enter USR_MGMT_NODE as the node name and 
then click Add. The Node Definition page is displayed.

d. Enter a description for the node in the Description field.

e. Make this node a remote node by deselecting the Local Node check box and 
selecting the Active Node check box.

f. On the Connectors tab, enter the following information and then perform a 
lookup:

Gateway ID: LOCAL

Connector ID: PSFT81TARGET

g. On the Properties tab, enter the following information:

Property ID: PSFT81TARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that is to receive the 
XML message. This URL is in the following format:

http://computer_name:port/peopleSoftUserMgmt/do/peopleSoftAction

For example:

http://172.21.109.75:8080/peopleSoftUserMgmt/do/peopleSoftAction

h. Click Save.

i. Click the Transactions tab, and then click Add Transaction. The Add 
Transaction page is displayed.

j. Enter the following details to define the new transaction:

Transaction Type: Outbound Asynchronous

Request Message: USR_MGMT_MSG

Request Message Version: VERSION_1

k. Click Add.

l. To keep the status as active, select Active.

m. Click Save to save the changes.
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3. To secure the USR_MGMT_MSGCH message channel:

a. Navigate to PeopleTools, Security, Permission & Roles, and Permission 
Lists.

b. Select AEAE1000. The AEAE1000 permission list is displayed.

c. Select the Message Monitor tab, and then click the button with the plus sign 
(+).

d. Enter USR_MGMT_MSGCH as the channel name.

e. Select Full Access from the list, and then click Save.

f. Click PeopleTools, Integration Broker, Monitor, Monitor Message, and 
Channel Status to check the status of the message channel. 

If the status of the USR_MGMT_MSGCH message channel is Pause, then click 
the Run button to activate it.

Creating the Application Engine Program
To create the Application Engine program:

1. Click Start, Programs, PeopleSoft8.x, and then Application Designer. The 
Application Designer window is displayed.

2. Select New from the File menu. The New Definition dialog box is displayed.

3. Select Application Engine from the Definition list. The App Engine Program 
window is displayed, and the Step01 step is created by default.

4. In the App Engine Program window, select Step01 and then select Action from 
the Insert menu.

5. Rename Step01 to currency.

6. From the list on the action, select PeopleCode. 

7. Select Save from the File menu, and save the Application Engine program with 
the name BLKPRCS_USER.

8. Double-click the PeopleCode action.

9. Copy the code from the CurrencyCode.txt file, which is in the 
OIM_home/xellerate/Scripts directory.

10. The code that you copy has the following default path for the output file in which 
the currency code data changes are to be stored:

C:/PT822/data/log/currency.txt

In the code, retain the file name (currency.txt) but change the path to any 
directory location on the PeopleSoft server. For example:

C:/MyDirectory/currency.txt

11. Save the PeopleCode action and close the window.

12. In the App Engine Program window, select the MAIN section and then select 
Step/Action from the Insert menu.

13. Repeat Steps 5 through 12 to create the remaining steps, which are listed in the 
following table.
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14. Save the Application Engine program.

Running the Application Engine Program
The procedure to run the Application Engine program depends on the release of 
PeopleTools that you are using:

■ Running the Application Engine Program on PeopleTools 8.22

■ Running the Application Engine Program on PeopleTools 8.45 Through 8.47

Running the Application Engine Program on PeopleTools 8.22  To run the Application Engine 
program on PeopleTools 8.22:

1. Log in to the PeopleSoft Enterprise Portal.

2. Click People Tools, Process Scheduler Manager, Use, and Process Definitions. 
The Process Definitions page is displayed.

3. Click Add a New value.

4. Select Application Engine from the Process Type list.

5. Enter the name of the Application Engine program as the process name, for 
example, BLKPRCS_USER. 

6. Click Add. 

7. Select the Application Engine Program from the search results that are displayed.

8. On the Process Definition Options tab, specify the following values:

■ Run Location: Server

■ Server Name: PSNT

■ Component: PRCSMULTI

■ Process Groups: ALLPANLS

9. Click Save.

10. Return to the home page.

11. Click People Tools, Process Scheduler Manager, Process, and Sample Processes. 
The Sample Processes page is displayed.

12. Click Add a New value.

13. Specify a run control ID, and then click Add.

Step Name File Containing the Required PeopleCode

language LanguageCode.txt

emplid EmployeeId.txt

userrole UserRoles.txt

permiss PermissionList.txt

EmailType (PeopleTools 8.45 through 
8.47 only)

EmailType.txt

addemp AddEmp.txt
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14. Click Run. The Process Scheduler Request page is displayed

15. Specify the server name.

16. Select the Application Engine program name, and then click OK.

17. Click Process Monitor to verify the status of the process.

After the process status changes to Success, the comma-separated file is created 
at the location specified in the code that you copy from the AddEmp.txt file.

Running the Application Engine Program on PeopleTools 8.45 Through 8.47  To run the 
Application Engine program on PeopleTools 8.45 through 8.47:

1. Open the application designer in 2-tier mode.

2. Specify the connection type, user ID, and password.

3. To open the Application Engine program that you create:

a. From the File menu, select Open and then select Application Engine Program 
from the Object Type list.

b. Select BLKPRCS_USER, and then click Open.

4. Click the RUN PROGRAM control on the toolbar below the menu bar. The code 
for the PeopleCode action is run. The comma-separated file containing user 
records is created at the location specified in the code.

Configuring Trusted Source Reconciliation
While configuring the connector, the target system can be designated as a trusted 
source or a target resource. If you designate the target system as a trusted source, then 
both newly created and modified user accounts are reconciled in Oracle Identity 
Manager. If you designate the target system as a target resource, then only modified 
user accounts are reconciled in Oracle Identity Manager.

1. Import the XML file for trusted source reconciliation, 
PSFTBaseXellerateUser.xml, by using the Deployment Manager. This 
section describes the procedure to import the XML file. 

Note: A run control ID is used as a key for records that contain the 
parameters required by a process at run time. If the parameters are 
stored in a table that the process can query using the run control ID 
and user ID, then the process can run without user intervention.

Note: For the Application Engine program to run in 2-tier mode, the 
database client must be installed on the server used for accessing the 
application designer. To switch to the 2-tier mode, you select 
Connection Type as the database on the PeopleSoft sign-on screen. 

Note: You can skip this section if you do not want to designate the 
target system as a trusted source for reconciliation.
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2. Specify values for the attributes of the PSFT Base Trusted User 
Reconciliation scheduled task. This procedure is described later in this guide.

To configure trusted source reconciliation:

1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management. A dialog box for locating 
files is displayed.

4. Locate and open the PSFTBaseXellerateUser.xml file, which is in the 
OIM_home/xlclient directory. Details of this XML file are shown on the File 
Preview page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation page is displayed.

7. Click Import. 

8. In the message that is displayed, click Import to confirm that you want to import 
the XML file and then click OK.

Configuring the Reconciliation Scheduled Tasks
When you perform the procedure described in the "Step 4: Importing the Connector 
XML Files" section on page 2-6, the scheduled tasks for lookup fields, trusted source 
user, and nontrusted user reconciliations are automatically created in Oracle Identity 
Manager. To configure these scheduled tasks:

1. Open the Oracle Identity Manager Design Console.

2. Expand the Xellerate Administration folder.

3. Select Task Scheduler.

4. Click Find. The details of the predefined scheduled tasks are displayed on two 
different tabs.

5. Enter a number in the Max Retries field. This number represents the number of 
times Oracle Identity Manager must attempt to complete the task before assigning 
the ERROR status to the task.

6. Ensure that the Disabled and Stop Execution check boxes are not selected.

7. In the Start region, double-click the Start Time field. From the date-time editor 
that is displayed, select the date and time at which you want the task to run.

8. To set the task to run only once, select the Once option in the Interval region.

9. Provide values for the attributes of the scheduled task. Refer to the "Specifying 
Values for the Scheduled Task Attributes" section on page 3-17 for information 
about the values to be specified.

Note: Only one target system can be designated as a trusted source. 
If you import the PSFTBaseXellerateUser.xml file while you 
have another trusted source configured, then both connector 
reconciliations would stop working.
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10. Click Save. The scheduled task is created. The INACTIVE status is displayed in 
the Status field, because the task is not currently running. The task is run at the 
date and time that you set in Step 7.

11. Repeat Steps 5 through 10 to create the second scheduled task.

After you create both scheduled tasks, proceed to the "Adding Custom Attributes for 
Reconciliation" section on page 3-19.

Specifying Values for the Scheduled Task Attributes
This section provides information about the values to be specified for the following 
scheduled tasks:

■ Lookup Fields Reconciliation Scheduled Task

■ User Reconciliation Scheduled Task

Lookup Fields Reconciliation Scheduled Task  You must specify values for the following 
attributes of the PSFT Base LookUp Reconciliation scheduled task.

Note: 

■ Attribute values are predefined in the connector XML file that you 
import. Specify values only for those attributes that you want to 
change.

■ Values (either default or user-defined) must be assigned to all the 
attributes. If even a single attribute value were left empty, then 
reconciliation would not be performed.

Attribute Description

ServerName Name of the IT resource

Default value: PSFT Base Server

LookupType The type of data that is being looked up in the target system.

The value can be any one of the following:

■ EmployeeId

■ LanguageCode

■ EmailTypes

■ CurrencyCode

■ PermissionList

■ UserRoles

FilePath Directory path on the Oracle Identity Manager server where the 
reconciliation lookup .txt file is stored

Sample value: 
C:/PSFTBase/LookupRecon/EmployeeIds.txt
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

User Reconciliation Scheduled Task  Depending on whether you want to implement 
trusted or nontrusted soured reconciliation, you must specify values for the attributes 
of one of the following user reconciliation scheduled tasks:

■ PSFT Base Trusted User Reconciliation (Scheduled task for trusted 
source reconciliation)

■ PSFT Base Non Trusted User (Scheduled task for nontrusted source 
reconciliation)

The following table describes the attributes of both scheduled tasks.

LookupName Name of the lookup definition configured in Oracle Identity 
Manager

The value can be any one of the following:

■ Lookup.PSFTBase.EmployeeId

■ Lookup.PSFTBase.LanguageCode

■ Lookup.PSFTBase.EmailType

■ Lookup.PSFTBase.CurrencyCode

■ Lookup.PSFTBase.PermissionList

■ Lookup.PSFTBase.Roles

TargetSystem Name of the resource object

Default value: PSFTBase

Note: 

■ Attribute values are predefined in the connector XML file that you 
import. Specify values only for those attributes that you want to 
change.

■ Values (either default or user-defined) must be assigned to all the 
attributes. If even a single attribute value were left empty, then 
reconciliation would not be performed.

Attribute Description

MultiValueSeperator ## is the multivalue separator in the flat file that is used for 
bulk reconciliation

ServerName Name of the IT resource instance

Default value: PSFTBase

IsTrusted Specifies whether or not reconciliation is to be carried out in 
trusted mode

Specify Yes for trusted source reconciliation.

Specify No for nontrusted source reconciliation.

Attribute Description
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After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

Adding Custom Attributes for Reconciliation

Standard change-based reconciliation involves the reconciliation of predefined 
attributes. If required, you can add custom attributes to the list of fields that are 
reconciled.

The procedure to add a custom attribute for reconciliation depends on the release of 
PeopleTools that you are using:

■ Adding a Custom Attribute for Reconciliation on PeopleTools 8.22

■ Adding a Custom Attribute for Reconciliation on PeopleTools 8.45 Through 8.47

Adding a Custom Attribute for Reconciliation on PeopleTools 8.22
To add a custom attribute for reconciliation on PeopleTools 8.22:

1. In PeopleSoft Application Designer:

a. Select Open from the File menu. The Open Definition dialog box is displayed.

b. Select Message from the Definition list, enter USR_MGMT_MSG in the Name 
Selection Criteria field, and then click Enter. The details of the 
USR_MGMT_MSG message are displayed.

c. Click the record to which you want to add custom attributes.

For example, suppose you want to add the job location attribute, LOCATION, 
then click JOB under VERSION_1.

d. Select the check box for the required attribute, and then save the message.

For example, select the LOCATION check box.

2. Make the required changes in the PeopleCode given in the 
UserMgmtCBRecon.txt file. This file is in the 
OIM_home/xellerate/Scripts directory. The required changes are as follows:

a. At the end of the SQL statements section, edit the SQL statement to retrieve 
the column values for the new attribute and store the values in local variables.

XellerateOrganization Default name of the Oracle Identity Manager organization

This value is used to create the Xellerate User in trusted mode.

Note: This attribute is specific to the scheduled task for trusted 
source reconciliation.

FolderPath Directory path on the Oracle Identity Manager server where 
the reconciliation lookup .txt file is stored

TargetSystem Name of the resource object

Default value: PSFTBase

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data.

Attribute Description
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For example, suppose you want to add the job location attribute, LOCATION, 
to the list of attributes that are reconciled. Then, performing this step involves 
editing the SQL statement as follows, so that it retrieves the values of the 
LOCATION column from the JOB table:

SQLExec("select DEPTID, JOBCODE, LOCATION from ps_job a where emplid =:1 
and effdt=(select max(effdt) from ps_job b where a.emplid=b.emplid and 
effseq =(select max(effseq) from ps_job c where b.emplid = c.emplid and 
b.effdt=c.effdt))", &empid, &deptid, &jobcd, &location);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the JOB tag, add 
the lines highlighted in bold in the following code sample:

/* FOR JOB RECORD */
&MSG_ROWSET.GetRow(1).JOB.JOBCODE.Value = &jobcd;
&MSG_ROWSET.GetRow(1).JOB.DEPTID.Value = &deptid;
&MSG_ROWSET.GetRow(1).JOB.LOCATION.Value = &location;

3. To extract the contents of the peopleSoftUserMgmt.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftUserMgmt.war

Copies of this file are in the application server deployment directory and the 
OIM_home/xellerate/webapp directory.

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the LOCATION 
attribute:

Users.LOCATION=//Transaction/DEPT_TBL/LOCATION

5. Delete the existing peopleSoftUserMgmt.war file from the temporary directory 
into which you extract it, and then enter the following command to re-create the 
file:

jar –cvf peopleSoftUserMgmt.war .

6. Delete the old version of the peopleSoftUserMgmt.war file from the 
application server deployment directory and the 
OIM_home/xellerate/webapp directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server deployment directory and the OIM_home/xellerate/webapp directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Add a column corresponding to the new attribute in the User Defined process 
form, UD_PSFT_BAS. For the example described earlier, you can add the 
UD_PSFT_BAS_LOCATION column.

b. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFTBase. For the example described earlier, you can add the 
Users.LOCATION reconciliation field.

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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c. Modify the PSFTBase process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the 
example described earlier, the mapping is as follows:

Users.LOCATION = UD_PSFT_BAS_LOCATION

d. Modify the attributemapping_recon.properties file, which is in the 
OIM_home/xellerate/XLIntegrations/PSFTBASE/config directory.

You can also add new attributes in this file. The format that you must use is as 
follows:

TargetAttribute=Users.OimAttributeName

For example:

LOCATION=Users.LOCATION

In this example, LOCATION is the reconciliation field and also the equivalent 
target system attribute. As a standard, the prefix "Users." is added at the 
start of all reconciliation field names.

9. Restart the Oracle Identity Manager server and client.

Adding a Custom Attribute for Reconciliation on PeopleTools 8.45 Through 8.47
To add a custom attribute for reconciliation on PeopleTools 8.45 through 8.47:

1. Make the required changes in the PeopleCode given in the 
UserMgmtCBRecon.txt file. This file is in the 
OIM_home/xellerate/Scripts directory. The required changes are as follows:

a. At the end of the SQL statements section, add a SQL statement to retrieve the 
column values for the new attribute and store the values in local variables.

For example, suppose you want to add the department location attribute, 
LOCATION, to the list of attributes that are reconciled. Then, performing this 
step involves adding the following SQL statement to retrieve the values of the 
LOCATION column from the PS_DEPT_TBL table:

SQLExec("SELECT DESCR, LOCATION FROM PS_DEPT_TBL WHERE DEPTID=:1", &deptid, 
&deptname, &location);

b. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the DEPT_TBL 
tag, add the lines highlighted in bold in the following code sample:

&recnode = &fieldtypenode.AddElement("DEPT_TBL");
&recnode.AddAttribute("class", "R");
&fields = &recnode.AddElement("DEPTNAME");
&fields.AddAttribute("type", "CHAR");
&fields = &recnode.AddElement("LOCATION");
&fields.AddAttribute("type", "CHAR");

c. Add the required lines at the end of the block of code for adding data to the 
XML message. For example, to add the LOCATION column to the DEPT_TBL 
tag, add the lines highlighted in bold in the following code sample:

&datarecnode = &transnode.AddElement("DEPT_TBL");
&datarecnode.AddAttribute("class", "R");
&datafldnode = &datarecnode.AddElement("DEPTNAME");
&textnode = &datafldnode.AddText(&deptname);
&datafldnode = &datarecnode.AddElement("LOCATION");
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&textnode = &datafldnode.AddText(&location);

2. In PeopleSoft Application Designer, copy the contents of the 
UserMgmtCBRecon.txt file into the savePostChange event for the 
PERSONAL_DATA component.

3. To extract the contents of the peopleSoftUserMgmt.war file into a temporary 
directory, enter the following command:

jar –xvf peopleSoftUserMgmt.war

Copies of this file are in the application server deployment directory and the 
OIM_home/xellerate/webapp directory.

4. In the attributemap.properties file, add the XPath (key-value entry) of the 
custom attribute. For example, you can add the following XPath for the LOCATION 
attribute:

Users.LOCATION=//Transaction/DEPT_TBL/LOCATION

5. Delete the existing peopleSoftUserMgmt.war file from the temporary directory 
into which you extract it, and then enter the following command to re-create the 
file:

jar –cvf peopleSoftUserMgmt.war .

6. Delete the old version of the peopleSoftUserMgmt.war file from the 
application server deployment directory and the 
OIM_home/xellerate/webapp directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server deployment directory and the OIM_home/xellerate/webapp directory.

8. In the Oracle Identity Manager Design Console, make the required changes as 
follows:

a. Add a column corresponding to the new attribute in the User Defined process 
form, UD_PSFT_BAS. For the example described earlier, you can add the 
UD_PSFT_BAS_LOCATION column.

b. Add a reconciliation field corresponding to the new attribute in the resource 
object, PSFTBase. For the example described earlier, you can add the 
Users.LOCATION reconciliation field.

c. Modify the PSFTBase process definition to include the mapping between the 
newly added attribute and the corresponding reconciliation field. For the 
example described earlier, the mapping is as follows:

Users.LOCATION = UD_PSFT_HR_LOCATION

d. Modify the attributemapping_recon.properties file, which is in the 
OIM_home/xellerate/XLIntegrations/PSFTBASE/config directory.

You can also add new attributes in this file. The format that you must use is as 
follows:

TargetAttribute=Users.OimAttributeName

For example:

See: Oracle Identity Manager Design Console for detailed instructions 
on performing the following steps
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LOCATION=Users.LOCATION

In this example, LOCATION is the reconciliation field and also the equivalent 
target system attribute. As a standard, the prefix "Users." is added at the 
start of all reconciliation field names.

9. Restart the Oracle Identity Manager server and client.

Encrypting a New Oracle Identity Manager Password
If the password of the Oracle Identity Manager administrator is different from the 
default password, then you must encrypt the Oracle Identity Manager password as 
follows:

1. On the Oracle Identity Manager server, open a command window.

2. In the command window, change to the OIM_home/xellerate/ScheduleTask 
directory.

3. Enter the following command:

java -classpath PSFTBaseReconciliation .jar  \
Com.thortech.xl.Integration.peoplesoft.util.tcUtilEncryption -e \
OIM_plaintext_password

In this command, OIM_plaintext_password is the new Oracle Identity 
Manager administrator password that you want to encrypt.

The encrypted password is displayed in the command window.

4. Copy the encrypted password into the xlsession.properties file. This file is 
compressed in the OIM_home/xlclient/lib/peopleSoftUserMgmt.war file. 

5. Delete the peopleSoftUserMgmt.war file from the temporary directory where 
you extracted its contents, and then use the following command to re-create the 
file:

jar –cvf  peopleSoftUserMgmt.war

6. Ensure that the old version of the peopleSoftUserMgmt.war file is removed 
from the application server (JBoss Application Server, IBM WebSphere, BEA 
WebLogic, or OC4J) deployment directory and the 
OIM_home/xellerate/webapp directory.

7. Copy the newly created peopleSoftUserMgmt.war file into the application 
server (JBoss Application Server, IBM WebSphere, BEA WebLogic or OC4J) 
deployment directory and the OIM_home/xellerate/webapp directory.

8. Restart the Oracle Identity Manager server and client.

Configuring Provisioning
As mentioned earlier in this guide, provisioning involves creating or modifying a 
user's account information on the target system through Oracle Identity Manager. 
Refer to the "Supported Functionality" section on page 1-4 for a listing of the 
provisioning functions that are available with this connector.

This section discusses the following topics related to configuring provisioning:

Note: The default administrator user ID is xelsysadm.
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■ Compiling Adapters

■ Adding Custom Attributes for Provisioning

■ Configuring the Target System for Provisioning

Compiling Adapters

Adapters are used to implement provisioning functions. The following adapters are 
imported into Oracle Identity Manager when you import the connector XML file:

■ adpPSFTCREATEUSER

■ adpPSFTUPDATEUSER

■ adpPSFTRESETPASSWORD

■ adpPSFTUNLOCKUSER

■ adpPSFTLOCKUSER

■ adpPSFTUPDATEUSEREMPID

■ adpPSFTADDORDELETEROLE

■ adpPSFTADDORDELETEEMAIL (PeopleTools 8.45 through 8.47 only)

You must compile these adapters before they can be used in provisioning operations.

To compile adapters by using the Adapter Manager form:

1. Open the Adapter Manager form.

2. To compile all the adapters that you import into the current database, select 
Compile All.

To compile multiple (but not all) adapters, select the adapters you want to 
compile. Then, select Compile Selected.

3. Click Start. Oracle Identity Manager compiles the selected adapters.

4. If Oracle Identity Manager is installed in a clustered environment, then copy the 
compiled adapters from the OIM_home/xellerate/Adapter directory to the 
same directory on each of the other nodes of the cluster. If required, overwrite the 
adapter files on the other nodes.

If you want to compile one adapter at a time, then use the Adapter Factory form.

Note: You must perform this procedure if you want to use the 
provisioning features of the connector.

See Also: The "Supported Functionality" section on page 1-4 for a 
listing of the provisioning functions that are available with this 
connector

Note: Click Compile Previously Failed to recompile only those 
adapters that were not compiled successfully. Such adapters do not 
have an OK compilation status.
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To view detailed information about an adapter:

1. Highlight the adapter in the Adapter Manager form.

2. Double-click the row header of the adapter, or right-click the adapter.

3. Select Launch Adapter from the shortcut menu that is displayed. Details of the 
adapter are displayed.

Adding Custom Attributes for Provisioning

To add a custom attribute for provisioning:

1. Modify the attributemapping_prov.properties file, which is in the 
OIM_home/xellerate/XLIntegrations/PSFTBase/config directory. At 
the end of this file, some of the attribute definitions are preceded by comment 
characters. You can uncomment the definitions of attributes that you want to use 
any one of them to make it a part of the provisioning attributes.

You can also add new attributes in this file. The format that you must use is as 
follows:

OimAttributeName=TargetAttributeName

For example:

If you want to add the AlternateUserID field, then add the following line in the 
attributemapping_prov.properties file:

AlternateUserID=AlternateUserID

2. Add a new column in the process form.

a. Open the process form. This form is in the Development Tools folder of the 
Oracle Identity Manager Design Console

b. Click Create New Version.

c. In the Create a New Version dialog box, specify the version name in the Label 
field, save the changes, and then close the dialog box.

d. From the Current Version list, select the newly created version.

e. On the Additional Columns tab, click Add.

f. Specify the new field name and other values.

3. Add a new variable in the variable list.

a. Open the Adapter Factory form. This form is in the Development Tools folder 
of the Oracle Identity Manager Design Console.

See Also: Oracle Identity Manager Tools Reference Guide for 
information about using the Adapter Factory and Adapter Manager 
forms

Note: In this section, the term "attribute" refers to the identity data 
fields that store user data.

See Also: Oracle Identity Manager Design Console Guide
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b. Click the Query for Records icon.

c. On the Adapter Factory Table tab, double-click the adpPSFTCREATEUSER  
adapter from the list.

d. On the Variable List tab, click Add.

e. In the Add a Variable dialog box, specify the required values and then save 
and close the dialog box.

4. Define an additional adapter task for the newly added variable in the 
adpPSFTCREATEUSER adapter.

a. On the Adapter Tasks tab of the Adapter Factory form, click Add.

b. In the Adapter Task Selection dialog box, select Functional Task, select Java 
from the list of functional task types, and then click Continue.

c. In the Object Instance Selection dialog box, select the Persistent instance and 
then click Continue.

d. In the Add an Adapter Factory Task dialog box, specify the task name, select 
the setProperty method from the Method list, and then click Save.

e. Map the application method parameters, and then save and close the dialog 
box. To map the application method parameters:

For the "Output: String Return variable (Adapter Variable)" parameter:

i. From the Map to list, select Literal.

ii. From the Name list, select Return variable.

For the "Input: String input (Adapter Variable)" parameter:

i. From the Map to list, select Adapter Variables.

ii. From the Name list, select Input.

For the "Input: String Status (Literal)" parameter:

i. From the Map to list, select Literal.

ii. From the Name list, select String.

iii. In the Value field, enter Status.

For the "Input: String Status (Adapter Variable)" parameter:

i. From the Map to list, select Adapter Variables.

ii. From the Name list, select Status.

f. Repeat Steps b through g' to create more adapter tasks.

5. Create an additional adapter task to set the input variable.

a. Open the Adapter Factory form. This form is in the Development Tools folder 
in the Oracle Identity Manager Design Console.

b. On the Adapter Tasks tab, click Add.

c. In the Adapter Task Selection dialog box, select Logic Task, select SET 
VARIABLE from the list, and then click Continue.

d. In the Edit Set Variable Task Parameters dialog box, select input from the 
Variable Name list, select Adapter Task from the Operand Type list, and the 
Operand Qualifier as the Adapter Task that you have created in the previous 
step. Then, click Save.
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6. Map the process form columns and adapter variables for the Create User process 
task as follows:

a. Open the Process Definition form. This form is in the Process Management 
folder of the Design Console.

b. Click the Query for Records icon.

c. On the Process Definition Table tab, double-click the PSFTBase process.

d. On the Tasks tab, double-click the Create User task.

e. In the Closing Form dialog box, click Yes.

f. On the Integration tab of the Editing Task Columns Create User dialog box, 
map the unmapped variables, and then save and close the dialog box. To map 
an unmapped variable:

i. Double-click the row in which N is displayed in the Status column. The 
value N signifies that the variable is not mapped.

ii. From the Map to list in the Edit Data Mapping for Variables dialog box, 
select Process Data.

iii. From the Qualifier list, select the name of the variable.

Repeat Steps i through iii for all unmapped variables.

Repeat Steps 1 through 6 if you want to add more attributes.

Configuring the Target System for Provisioning
This section describes the following procedures to be performed on the target system:

■ Creating the APIs for the Component Interface

■ Creating the Java Template for the Component Interface

Creating the APIs for the Component Interface
To create the APIs for the component interface:

1. Open the Application Designer by clicking Start and then selecting Programs, 
Peoplesoft8.x, and Application Designer. The Application Designer window is 
displayed.

2. In the Application Designer window, select Open from the File menu. The Open 
Definition dialog box is displayed.

3. In the Open Definition dialog box, select Component Interface from the 
Definition list.

4. Enter USER_PROFILE in the Name field, and then press Enter.

All the component interfaces with names that start with USER_PROFILE are 
displayed in the Open Definition dialog box.

5. Select the USER_PROFILE entry, and then click Open.

6. Click Yes in the message that is displayed. The properties of the USER_PROFILE 
component interface are displayed.

7. In the window for the USER_PROFILE component interface, select PeopleSoft 
APIs from the Build menu. The Build PeopleSoft API Bindings dialog box is 
displayed.

8. In the Java Classes region, select the Build check box.
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9. From the Select APIs to Build list, select CompIntfc.CompIntfcPropertyInfo, 
CompIntfc.CompIntfcPropertyInfoCollection, and the APIs with names that start 
with CompIntfc.USER_PROFILE.

10. In the Target Directory field, specify the path of the directory in which you want 
the Java API classes to be created, and then click OK.

11. Ensure that the psjoa.jar file is set in the CLASSPATH environment variable. 
This file is in the OIM_home/xellerate/ThirdParty directory.

12. Compile the APIs from the target directory specified in the preceding step.

13. Bundle the compiled class files in a JAR named peoplesoft.jar as follows:

jar -cvf peoplesoft.jar PeopleSoft/Generated/CompIntfc/*.class

Creating the Java Template for the Component Interface
To create the Java template for the component interface:

1. On the right pane of the window for the USER_PROFILE component interface, 
right-click USER_PROFILE.

2. Select Generate Java Template from the shortcut menu. A message showing the 
name and path of the Java template is displayed.

3. Click OK to close the message.

Configuring the Connector for Multiple Installations of the Target System

You may want to configure the connector for multiple installations of PeopleSoft User 
Management. The following example illustrates this requirement:

The Tokyo, London, and New York offices of Acme Multinational Inc. have their own 
installations of PeopleSoft User Management. The company has recently installed 
Oracle Identity Manager, and they want to configure Oracle Identity Manager to link 
all the installations of PeopleSoft User Management.

To meet the requirement posed by such a scenario, you must configure the connector 
for multiple installations of PeopleSoft User Management.

To configure the connector for multiple installations of the target system:

1. Create and configure one IT resource for each target system installation.

The IT Resources form is in the Resource Management folder. An IT resource is 
created when you import the connector XML file. You can use this IT resource as 
the template for creating the remaining IT resources, of the same IT resource type.

2. Configure reconciliation for each target system installation. Refer to the "Partial 
Reconciliation" section on page 3-1 for instructions. Note that you only need to 
modify the attributes that are used to specify the IT resource and to specify 
whether or not the target system installation is to be set up as a trusted source.

Note: Perform this procedure only if you want to configure the 
connector for multiple installations of PeopleSoft User Management.

See Also: Oracle Identity Manager Design Console Guide for detailed 
instructions on performing each step of this procedure
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3. If required, modify the fields to be reconciled for the Xellerate User resource 
object.

Additional Steps for Configuring Change-Based Reconciliation
For change-based reconciliation, you must perform the procedure described in the 
following sections:

■ Configuring the Target System for Reconciliation on page 3-5

■ Configuring the PeopleSoft Listener Web Service for Change-Based Reconciliation 
on page 3-2

The following are actions that you must perform differently from the procedure 
described in these sections:

■ In Step 4.b of the "Configuring PeopleSoft Enterprise Portal on PeopleTools 8.22" 
section on page 3-8:

Change the Java command in the publish.bat file as shown in the following 
example:

java Com.thortech.xl.Integration.msgpublisher.PeopleSoftPublisher 
"http://host:port/peopleSoftUserMgmt1/do/peopleSoftAction" "C:/test/file" 
USR_MGMT_MSG >> c:/test/consolelog.log

Similarly, change the name of the Web application for each WAR file that you 
create.

■ In Step 7 of the procedure to create the XL_NODE node, given in the "Configuring 
PeopleSoft Enterprise Portal on PeopleTools 8.45 Through 8.47" section on 
page 3-11:

Change the name of the application in the URL as shown in the following 
example:

http://computer_name:port/peopleSoftUserMgmt1/do/peopleSoftAction

Similarly, change the name of the Web application in the URL for each WAR file 
that you create.

■ In the "Configuring the PeopleSoft Listener Web Service for Change-Based 
Reconciliation" section on page 3-2:

In Step 3, the value that you specify for the ObjectName parameter in the 
xlsession.properties file must be the name of the resource object that you 
create.

In Step 7, specify a different file name in the command that you use to re-create 
the WAR file. For example:

jar –cvf peopleSoftUserMgmt1.war

Similarly, change the name of the WAR file for each target system installation

Note: Perform this step only if you use PeopleTools 8.22.

Note: Perform this step only if you use PeopleTools 8.45 through 
8.47.
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4
Testing and Troubleshooting

After you deploy the connector, you must test it to ensure that it functions as expected.  
This chapter discusses the following topics related to connector testing:

■ Testing Reconciliation

■ Testing Provisioning

■ Troubleshooting

Testing Reconciliation
Running test cases for reconciliation involves verifying that the PeopleSoft Listener 
Web application can reconcile employees into Oracle Identity Manager. The following 
sections provides instructions to perform this test.

Prerequisites for Testing the PeopleSoft Listener Web Application
The following are prerequisites for testing the PeopleSoft Listener Web application:

■ Ensure that the Microsoft Windows scripting engine is installed. This is required 
to run VBScript files.

■ Ensure that the PeopleSoft XML message schema is described in the 
USR_MGMT_MSG.xml file, which is in the OIM_home/xellerate/test 
directory.

Testing the PeopleSoft Listener Web Application
To test the PeopleSoft Listener Web application:

1. In the OIM_home/xellerate/test/cbrecon/psft-xel-test.vbs file:

■ Modify the value of the ps_server_url variable so that it points to the URL 
for the PeopleSoft Listener Web application.

■ Specify the required PeopleSoft attributes and employee data values in the 
ExecuteATM function.

2. Run psft-xel-test.vbs. Ensure that the script runs without any errors.

When the script is run, it creates a reconciliation event. Verify that the reconciliation 
event is created in Oracle Identity Manager and that the event contains the data that 
you specify in the VBScript file.
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Performing Trial Reconciliation
Refer to the "Partial Reconciliation" section on page 3-1.

Testing Provisioning
You can use the testing utility to identify the cause of problems associated with 
connecting to the target system and performing basic operations on the target system.

Before you use the testing utility, you must set the required values in the 
config.properties file. This file is in the 
OIM_home/xellerate/XLIntegrations/PSFTBase/config directory.

Use the information in the following table to modify the default attributes of the 
config.properties file.

Name Description Sample Value

serverName IP address or host name of the PeopleSoft User 
Management server

172.21.109.95

serverPort Port at which the PeopleSoft User Management server is 
listening

9000

admin User ID of the PeopleSoft User Management server 
administrator

PS

ciName Component interface used to load user data in PeopleSoft 
User Management

USER_PROFILE

NumberOfRetries Number of times the connection to the target system must 
be retried before the InvocationTargetException is 
thrown

2

DelayBetweenRetr
ies

Time difference between subsequent retries (in 
milliseconds)

10000

action Action to be performed You can specify one of the 
following values:

CONNECT

CREATE

UPDATEUSERINFO

UPDATEUSER_EMPID

UPDATEPASSWORD

userId User login ID PSFTTEST

userDescription Description of the user PSFTTEST

primaryEmailAddr
ess

Primary e-mail address PSFTTEST@psft.com

primaryEmailType E-mail type of the primary e-mail account BUS

password Password of the user password

languageCode Language code for the user ENG

currencyCode Currency code for the user USD

recName Used to validate the employee ID during user 
provisioning in PeopleSoft User Management

PERSONAL_DATA

empId Employee ID for the user A10000
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After you specify values in the config.properties file, run one of the following 
files:

For UNIX:

OIM_home/xellerate/XLIntegrations/tests/scripts/PSFTBase.sh

For Microsoft Windows

OIM_home\xellerate\XLIntegrations\tests\scripts\PSFTBase.bat

Troubleshooting
The following table lists solutions to some commonly encountered issues associated 
with the PeopleSoft User Management connector.

primaryPermissio
nList

Primary permission list for the user HCCPAM1

userIdAlias User ID alias PSFTTEST1

symbId Specifies the AccessId associated with the user profile

The AccessId specifies whether or not the user has 
sufficient privileges on the PeopleSoft User Management 
database.

PS89

attrName Name of the attribute to be updated You can specify one of the 
following values:

USER_DESCRIPTION

EMAIL_ADDRESS

EMAILTYPE

MULTI_LANGUAGE_CODE

LANGUAGE_CODE

CURRENCY_CODE

attrValue Value of the attribute to be updated The value that you provide 
must correspond to the 
attribute name that you 
specify as the value of the 
attrName parameter.

Problem Description Solution

Oracle Identity Manager cannot 
establish a connection with the 
PeopleSoft User Management server.

■ Ensure that the PeopleSoft User Management 
server is running.

■ Ensure that Oracle Identity Manager is 
running.

■ Ensure that all the adapters have been 
compiled.

■ Use the IT Resources form to examine the 
Oracle Identity Manager record. Ensure that 
the IP address, admin ID, and admin 
password are correct.

Name Description Sample Value
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The Operation Fail message is 
displayed on the Oracle Identity 
Manager Administrative and User 
Console.

■ Ensure that the values for the attributes do not 
contain delimiter characters, such as white 
space and commas.

■ Ensure that the attribute values do not exceed 
allowable length.

The Create User adapter is triggered 
even when the pre-populate adapter 
is run successfully.

Set the property associated with the user ID 
attribute in the process form as required.

Problem Description Solution
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5
Known Issues

The following are known issues associated with this release of the connector:

■ Secure Sockets Layer (SSL) connections are not supported.

■ The connector files for PeopleTools 8.22 and PeopleTools 8.45 through 8.47 cannot 
be deployed on the same Oracle Identity Manager installation.

■ Some Asian languages use multibyte character sets. If the character limit for the 
fields in the target system is specified in bytes, then the number of Asian-language 
characters that you can enter in a particular field may be less than the number of 
English-language characters that you can enter in the same field. The following 
example illustrates this limitation:

Suppose you can enter 50 characters of English in the User Last Name field of the 
target system. If you were using the Japanese language and if the character limit 
for the target system fields were specified in bytes, then you would not be able to 
enter more than 25 characters in the same field.
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A
Attribute Mappings Between Oracle Identity 
Manager and PeopleSoft User Management

The following table discusses attribute mappings between Oracle Identity Manager 
and PeopleSoft User Management.

Oracle Identity Manager 
Attribute

PeopleSoft User 
Management Attribute Description

Lookup Fields

LanguageCode PSXLATITEM.FIELDVALUE
, 
PSXLATITEM.XLATLONGN
AME

Language code

EmployeeId PS_PERSONAL_DATA.EMP
LID, 
PS_PERSONAL_DATA.NA
ME

Employee ID

CurrencyCode PS_CURRENCY_CD_TBL.C
URRENCY_CD, 
PS_CURRENCY_CD_TBL.D
ESCR

Currency Code

PermissionList PSCLASSDEFN.CLASSID,PS
CLASSDEFN.CLASSDEFND
ESC

Permission List

EmailType PSXLATITEM.FIELDVALUE
, 
PSXLATITEM.XLATLONGN
AME

E-mail Type

UserRoles PSROLEDEFN.ROLENAME, 
PSROLEDEFN.DESC

User Roles

User Attributes

User Id PSOPRDEFN.OPRID User login ID

User Description PSOPRDEFN.OPRDEFNDES
C

Description of user

Employee Id PSOPRDEFN.EMPLID Employee ID

Primary Email Address PSUSEREMAIL.EMAILID E-mail address (primary e-mail account)

Primary Email Type PSUSEREMAIL.EMAILTYPE Email type (primary e-mail account)

Multi Language Code PSOPRDEFN.MULTILANG Multilanguage code
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Language Code PSOPRDEFN.LANGUAGE_
CD

Language code

Currency Code PSOPRDEFN.CURRENCY_C
D

Currency code

User Id Alias PSOPRDEFN.USERIDALIAS Alias of user login ID

Row Security Permission 
List

PSOPRDEFN.ROWSECCLAS
S

Row security parameter

Process Profile Permission 
List

PSOPRDEFN.PRCSPRFLCLS Process profile parameter

Navigator Home Permission 
List

PSOPRDEFN.DEFAULTNA
VHP

Navigator home page address

Primary Permission List PSOPRDEFN.OPRCLASS Primary permission list

Email Address PSUSEREMAIL.EMAILID E-mail address

Email Type PSUSEREMAIL.EMAILTYPE E-mail type

RoleName PSROLEUSER_VW.ROLENA
ME

Role name

Oracle Identity Manager 
Attribute

PeopleSoft User 
Management Attribute Description
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M
mapping between attributes of target system and 

Oracle Identity Manager, A-1
multilanguage support, 1-5

O
Oracle Identity Manager Administrative and User 

Console, 2-6, 3-16, 4-4
Oracle Identity Manager server, configuring, 2-3

P
parameters of IT resources, 2-7
password, encrypting, 3-23
problems, 4-3, 5-1
process tasks, 1-4
provisioning

functions, 1-4
publishing message, 3-7

R
reconciliation

functions, 1-4
lookup fields, 1-1
module, 1-1
trusted source mode, 1-6, 2-2
user, 1-2

reconciliation type
bulk, 1-3
change-based, 1-3

requirements for deploying, 2-1
running Application Engine program, 3-14

S
scheduled tasks

defining, 3-16
lookup fields reconciliation, 3-17
user reconciliation, 3-18

securing message channel, 3-13
server cache, clearing, 2-3
Simple File Handler, 3-9
supported

functionality, 1-4
languages, 1-5
releases of Oracle Identity Manager, 2-1
target system host platforms, 2-1
target systems, 2-1

T
target system, multiple installations, 3-28
target systems

host platforms supported, 2-1
supported, 2-1

testing, 4-1
testing provisioning, 4-2
testing reconciliation, 4-1

testing the connector, 4-1
testing utility, 4-1, 4-2
troubleshooting, 4-3
trusted source reconciliation, 1-6, 2-2

U
user attribute mappings, A-1
user reconciliation, 1-2
user reconciliation scheduled task, 3-18

V
version number of connector, determining, 1-8

X
XML files

description, 1-6, 2-2
for trusted source reconciliation, 1-6, 2-2
importing, 2-6
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